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IL-Quick-Start

IL Cameras ship from Fastec with:

1.	 CAT 6 Ethernet cable (6’)
2.	 12v Power Supply with Lemo camera connector
3.	 USB Flash Drive with Software and Manuals
4.	 16GB SDHC SD card
5.	 Lemo to 3 x BNC I/O cable (Trigger-in, Sync-in, Sync-

out)
6.	 C-mount body cap
7.	 3/32 Allen wrench for C-mount back-focus adjustment

Equipment

Need additional help?
Email: Support@fastecimaging.com
Register for Tutorials, Tools, Updates, etc.

IL Options and Accessories:

1.	 F-mount or PL-mount (mounted on camera) If present, 
C-mount, adjustment shims and, 5/32 wrench will be 
included.

2.	 WiFi USB adapter
3.	 Lemo to 6 x BNC I/O cable (Trigger-in, Trigger-out, Sync-

in, Sync-out, Arm-in, Arm-out)
4.	 Trigger Switch
5.	 Additional 16GB or 32GB SDHC SD card
6.	 Lenses 
7.	 Tripod and/or Magic arm
8.	 Lights and light stands

Control PC Requirements:

1.	 Windows PC (running Win7, 8, or 10), or Mac PC (Mountain Lion or higher)
2.	 6 GB of memory for 1-camera systems, 2GB additional memory recommended for each additional 

camera 
3.	 Gigabit Ethernet controller. Support for 9K Jumbo packets is recommended. (qualifying 

Thunderbolt-2 and USB-C to Gig-E adapters are available)
4.	 PC storage for image files: SSD recommended

mailto:Support%40fastecimaging.com?subject=IL5%20Setup%20Help
https://www.fastecimaging.com/plans/membership/
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1. USB OTG  (Micro A/B)

2. SDHC (SD-Card slot)

3. GigE Port (RJ45)

4. Sync I/O, Trigger (Lemo)*

5. HDMI Port (Type A)

6. DC Power In (Lemo)**

7. On/Off button

1. Power LED

2. Network Activity LED

3. Storage Activity LED

4. Camera Status LED

5. Sync Activity LED
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*Warning: LVTTL 3.3v max 
**10vdc to 26vdc

Camera LEDs, I/O
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Before setting up the ILx, you must first install the Fastec FasMotion Controller software on a Windows PC 
or Mac.

With it you may configure all recording parameters including Recording Mode, Session Length, 
Resolution, Frame Rate, Exposure, Color Balance, Autosave, Trigger point, and Sync options.

To install the Windows version onto a PC:
1.	 Run the FasMotion install file, FasMotion_2.4.2.exe (or some other version), on your PC. You may wish 

to copy the install file to a secure location on your PC for storage.
2.	 Follow the prompts to install and run FasMotion.

To install the Mac version:
1.	 Copy the FasMotion_2.4.2.dmg (or some other version), to your Mac.
2.	 Double click on the .dmg file to install.
3.	 Move the FasMotion icon to the Applications folder. Once installed, FasMotion will look and behave 

the same on a PC and Mac. All instructions below, as well as those found in the IL3 / IL4 / IL5 
Operator’s Manual are applicable to either version.

Network Setup on the Computer:
1.	 Disable all network adapters on the computer (including WiFi) except for the one to be used for the 

camera.
2.	 Configure Local Area Connection Properties for Internet Protocol Version 4 (TCP/IPv4) to obtain an IP 

address automatically (DHCP).
3.	 In Advanced settings for the Gig-E adapter , turn on “Jumbo Frames” (9000k) if available. (For more 

network settings, please refer to the Operator’s Manual.)
4.	 Connect the camera to the computer’s Gig-E port using CAT-5e or CAT-6 Ethernet cable.

Software

To Set the Language for FasMotion:
1.	 Select “Language” from the View menu in FasMotion.
2.	 Select the language of your choice.

Language
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Connect

Power up the camera:
•	 The camera will begin to boot up as soon as power is applied. 

During the power-up cycle, first the Camera LED will go green for 
a about 15 seconds, then the Power LED will go green and stay on. 
Within about 45 seconds both the Camera LED and the Power LED 
will be green. At this point the camera is booted up. 

•	 The On/Off button on the camera may be used to turn the camera 
off and on while connected to power.

Once connected to FasMotion, the camera may be powered down via 
the software: Camera/Power down

Note: If the camera is shut down by simply removing the power, the 
camera’s current configuration will not be saved.

Power

Connect the IL camera directly to the network interface of the PC or to a connected wired network 
using the CAT 6 cable provided with the camera.

All IL and TS cameras on the network should appear in the “Found Cameras” window in FasMotion.  

Cameras are listed by name and 
other identifying information 
including IP address, serial number, 
etc. 

Double-click on the line for any 
camera you wish to open in 
FasMotion. 
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If the camera window opens without an image:
•	 Check that all instances 

of FasMotion are included 
in the “Allowed programs 
to communicate through 
Windows Firewall”

•	 Disable unused NICs including 
WiFi

If the camera does not appear in 
the Found Cameras window:
•	 Make sure you have selected 

the correct Network interface 
from the drop-down list

•	 If there is a direct connection 
between the camera and PC, 
you may need to reboot the 
PC with the camera connected 
and powered on in order to get 
a connection

User Preferences opens from the File menu:
•	 Network settings for optimizing UDP transfers from the 

cameras. See Appnote  5 in the Operator’s manual for details.
•	 Enable check boxes for Statistics (logs file download 

statistics), Multi-Camera Control, and the Factory Menu (for 
service and support)

•	 Logging Level control (for service and support)

 Camera Preferences dialog opens from the Camera menu:
•	 JPEG quality controls the relative size and quality of JPEG and AVI files saved from the ILx. The 

range goes from 1 to 100. The default setting, 80, is a good compromise between quality and size.
•	 Set the Gamma to the setting in which the displayed image (on the computer display or HDMI 

monitor) best matches the scene. Most LCD and LED monitors will look best at 2.2. Use 1.0, the 
default, if in doubt to preserve image quality, then adjust as a 
post-process via the Display tab.

•	 Auto-download Metadata automatically downloads metadata 
used by FasMotion track the location of I/O data used for 
creating markers in Playback.

Preferences
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Record Setup

Open the Record Settings Tab on the Control Panel
Resolution, Frame Rate and Exposure:
•	 Use the Frame Aspect Ratio pull-down to select the shape of your 

Region of Interest (ROI)
•	 Adjust the Width and Height sliders or for the required resolution. 
•	 Select the Frame Rate for your recording using the Frame Rate slider or 

edit box.
•	 Adjust the Shutter Speed to get the proper exposure for your recording.
•	 Cameras with the Dual Mode, “D” option, may be used in either “Basic” 

mode, or “Long Recording” mode, controlled by the LR Mode check 
box on the Record Settings tab. (This setting is grayed-out on the 
IL3.)When this selection is changed, the camera will reboot into the 
selected mode. When going from “Long Recording” to “Basic” mode, 
the SSD will have to be reformatted before it can be accessed.  

In Long Recording (LR) mode, select Basic or FasCorder ROC (Record on 
Command) or BROC (Burst Record on Command) via the radio buttons on 
the Record tab.
For Standard and Long Record Basic mode recordings:
•	 Click on the Green Arm button  to begin recording.
•	 Click on the Red Trigger button to record post-trigger frames and 

end the recording.

For Long Record FasCorder ROC recordings, the Arm button is used to 
begin the session, and then the Trigger button toggles the camera between 
recording and paused states. Click on the Arm button again to stop the 
session and go to Playback.

BROC recordings work similarly: Arm to begin and end sessions, but the 
camera records a specified number frames (a burst of frames) each time it 
receives a trigger.

Open the Record Control Tab to Set the Trigger Position For Standard and LR Basic Recordings:

•	 With the trigger slider all the way to the left (0%), the (Armed) ILx 
will begin recording images when a trigger is received. It will stop as 
soon as the session buffer is full.

•	 With the trigger slider all the way to the right (100%), the (Armed) 
ILx will begin recording images into a circular buffer and will stop 
recording when it receives a trigger.

•	 With the trigger slider at 50%, the (Armed ) ILx will record into 1/2 
the session length into a circular buffer, then record the last 1/2 of 
the session after it receives a trigger.

Trigger position is not used for LR FasCorder (ROC or BROC) recordings.

Triggering
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Playback

Playing Back captured Video: 
Video Controls will become 
available immediately when a 
capture has been completed, when 
a CAP file has been loaded into 
memory, when a video has been 
selected for playback via “Open 
Video File...” from the File menu, or 
when the operator clicks on the Red 
Review button . 
•	 The Playback Bug can slide to 

any frame of the video. The Start 
and End Clip Bumpers can be 
moved to limit the playback to 
any portion you choose. The 
bumpers may be moved with 
the mouse or by clicking on the 
Start Clip or End Clip buttons, 
which move the chosen bumper 
to the present frame. Start and 
End Clip locations are also used 
to choose the portion of the 
recording to be saved.

•	 The playback buttons function 
as follows: 

	 move to beginning
	 one frame back
	 play backwards
	 pause
	 play
	 one frame forward
	 move to end
	 move to trigger frame.

Start Clip Bumper End Clip BumperPlayback Bug

Previous Marker Next Marker

Event Markers may be enabled via the Event Marker Control 
dialog accessed via the image window context menu.
 
If Event Markers are enabled, and buttons are used to jump 
between events. Notice in the figure, below, that the icons now 
include the letter “E.”
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Save Video

Saving captured video:

The Save Video dialog box opens by selecting “Save Video File...” 
from the File menu or the image window context menu, or by simply 
typing Ctrl+S. 

1.	 Set the target location from the radio buttons: Path (to a 
computer drive), SSD (to the camera’s internal hard drive), SD 
Card (to an SD Card in the camera), or USB (to a USB device 
connected to the camera).

2.	 Adjust start and end frames (this can also be done using the 
bumpers in the playback controls).
•	 This feature is not available for CAP (Partition) files

3.	 Select the “Save Type”--this may be AVI, DNG, BMP, JPEG, TIFF, 
or CAP file (available file types vary depending on media).

4.	 Click on “Save” to begin the transfer.

Some Save options depend on file types chosen:

•	 If an AVI file is saved to the computer (Path), the Image format 
choices are JPG (compressed MJPEG images) or BMP (un-com-
pressed bitmaps). 

•	 If a JPG Stack or and AVI/JPG is saved, the JPEG Quality slider 
becomes active, allowing adjustment of the compression/qual-
ity.

•	 If a TIF Stack is saved, the Raw (unprocessed) check box becomes active. Note that the TIF(raw) 
format is a mono (not colorized) image. 

•	 TIF-Raw, DNG, and CAP files are the only file types not subject to processing on the camera. They 
are also the only file types in which the full bit depth is maintained. (All other file types are saved 
in 8 bits.)

Contact Us!
We want your experience with FASTEC cameras to be as pleasant and productive as 
possible!

We are also very interested to know how your camera is working for you and if there is 
anything we can do to improve  your results, whether that is helping you find the best 
lens, or helping with camera setup. 

Do not hesitate to reach out to us:

Fastec Imaging Corporation
17150 Via Del Campo, Ste. 301, San Diego, CA 92127
+1-858-592-2342

 support@fastecimaging.com


